DAQ in a nutshell

Contents
Starting DATE 2
What do all the windows mean? 2
21 Themainwindow . . . . . . . . ... L 2
22 TheTCSstatuswindow . . .. ... ... .. ... 3
23 TheSMIstatuswindow . . ... ... ... ... .. .. ... ... . ..., 4
24 TheStatusDisplay . .. .. ... .. ... ... .. ... ... ... ... ... 4
Starting and Stopping Runs 4
31 Starting . . . .. ... 5
32 Running . ... ... ... ... e 5
33 Stopping . . . . . .. e 5
Configuration 6
4.1 Including/Excluding Detectors . . . . .. ... .. ....... ... . .... 6
42 TriggerSelection. . . . .. ... ... .. ... . 6
4.3 Deadtime Selection . . . . .. ... ... L o 6
44 Calibration Triggers . . . . . . . .. ... ... ... L 7
45 OnlineFilter . . . . .. . .. e 7
Error Recovery 7
5.1 Console access to the computers in the DAQbarrack. . . . .. ... ... ... 7
5.2 Problems starting dateControl . . .. ... ... ... ... ........... 8
5.3 Connection problem with XXX . . . ... ... .. ... .. ... ... ... 8
5.4 LDC does not receive START_OF_DATA within timeout . . . . ... ... ... 8
55 Rundoesnotend ... ... ... ... ... 8
5.6 Run control windows are frozen/notrepainted . . . . . .. ... ... ... .. 9
DAQ Shutdown in case of a Power Cut 10
6.1 TheProcedure . . . . .. ... ... ... ... 10
6.2 Possible Complications . . . . .. .. ... .. ... ... 00 L. 10
6.3 Switching on again after powerisrestored . ... ... ... ... ....... 10
Advanced Topics 11
7.1 Running commands on all machinesinparallel . . . . . ... ... ....... 11

7.2 Accessing the Databases . . . .. .. ... .................. ... 11



1 Starting DATE

The command |dateControl | starts all processes which are necessary to run DATE:

e Every computer taking part—either as GDC!, LDC?, TriggerHost®> or EDM*—needs
to have an rcServer process running, which acts on behalf of the runControl. The
presence of the rcServers is checked for all possible hosts and instances are started
if necessary. Problems starting the rcServer are indicated in red color and should be
acted upon as indicated; see section 5.2 for more details.

e The interoperation of the participating computers is coordinated by the runControl
background process, aided by several state machines; the latter being represented in
the system by processes named smiSM and accompanied by instances of smi_timeout
and compass_script. The existence of this set of processes is checked by dateControl
and they are started if necessary. Beware that the check for existence is global—in
the sense that they are detected also if they are running on a different host—while
the starting is done locally. It should not be possible (and generate an error message)
if this is done on computers which are reserved for other purposes, like pccofeXX or
pccorbXX, but it should still be customary to start them only on pccorc01, unless forced
otherwise.

e The interface to the shift crew is displayed by a runControlHI process, which is started
last. Its usage will be detailed in the following sections, but one feature is interest-
ing here: the shift crew interface can also be started separately by issuing the
command. Several interfaced can be running at the same time, but only one can ac-
tually have control, symbolized by a lock icon next to the COMPASS logo. When the
lock is locked and green, this interface can control the DATE processes; click the lock
and select unlock to relinquish control. When the lock is locked and red, some other
interface has control and the present one can only be used for monitoring. When the
lock is unlocked and gray;, it can be clicked to obtain control over the DATE processes.

dateHI always starts a shift crew interface, whether the other needed processes are
running or not. In the latter case it says RC not running below the COMPASS writing
and you have to close the interface (Close HI from the File menu) and start over with
dateControl.

Summary: If you want to actually control DATE, use [dateControl|, preferably on pc-
corcO1. If you are sure that DATE is running and you want to peek over the shift crew’s
shoulder you can use from any pccorcXX or pccogwXX computer.

2 What do all the windows mean?

2.1 The main window

After starting up, there is only the main run control window with the COMPASS logo, the
control buttons and the log. Directly above the log it displays the current run number—the
tield is empty and very small at first—and the run control status. Above the run status line

1 global data concentrator, aka event builder

2local data concentrator, aka ROB or readout buffer

Sresponsible for running the scripts which start and stop the trigger
*event distribution manager



is the strip with settings for number of bursts, online filter, trigger conditions, SLinks and
calibration triggers, which will be detailed later on. The main DATE control is exerted via
the buttons between the COMPASS logo and the aforementioned strip.

The DATE system can either be in one of the four following states or transitioning be-
tween them:

DISCONNECTED This is the initial state, which allows the configuration of participating
computers to be changed; see section 4.1 for details.

CONNECTED In this state the set of participating computers is fixed, but their con-
figuration could be changed using the Define button below the Con-
nected Run Parameters label. This is not usually necessary for the shift
crew and the DAQ expert should be consulted before any modifica-
tion.

READY This should be the default state when no run is running. Online filter
and trigger conditions as well as calibration triggers can be set in this
state, otherwise the DAQ is only awaiting the command to start a run.

RUNNING This should be the most used state during physics beam, as now data
are (hopefully) on their way to disk.

These four states are depicted from left to right in the boxes titled Disconnected Configu-
ration, Connected Run Parameters, Ready to start and Data Taking. To move between the first
three, use the arrow buttons between the boxes, but be aware that the transition from DIS-
CONNECTED to CONNECTED state usually takes half a minute, more if an error happens.
The currently active box is highlighted with a pink label.

When the DAQ is in the READY state, you can switch on/off the recording, the event-
builder and the EDM (Event Distribution Manager). While the latter is optional, the event
building must always be switched on! We normally also keep recording enabled except
when the data really are not interesting for anyone. Starting and stopping a run is discussed
separately in section 3.

2.2 The TCS status window

This window is not visible in the disconnected state. If it does not appear after connecting
(or someone has closed it) you can open it using Show TCS Status from the View menu.

In former times we had a script named check_trigger which had to be manually exe-
cuted to read the values from the prescaler. The information is now displayed continuously
in a run control window to make the trigger system more transparent for the user. Be-
sides the prescaler status, some information from the TCS controller is shown, namely the
burst status (0 means offspill, 1 means that particle extraction is going on), the current burst
number and the number of accepted triggers in the last spill, grayed out during the spill to
indicate updating in progress.

In case the two status labels for the TCS controller and prescaler do not contain the word
“okay” in green color, something is wrong with the TCS and must be fixed before a run
can be started. An exception is the moment directly after opening the TCS status window,
during which the TCS status is first read. Click on the “?” buttons to see which action is
necessary. After a reboot of the VME crates housing the TCS components it takes about 1
minute for the state to change to “okay”.



2.3 The SMI status window

This window is not visible in the disconnected state. If it does not appear after connecting
(or someone has closed it) you can open it using Show SMI Status from the View menu.

The internal workings of DATE are expressed in terms of state machine logic. This en-
ables the very concise and immediate display of the state of all system components in one
window. During one cycle of starting and stopping a run, all green state indicators move
from the top to the bottom of their respective range. Click on the yellow bars to see which
computer is represented by each one.

The GDC indicators should move first and up to the RUNNING state, then the LDC indi-
cators move up to WAITING_START_OF_DATA, after which at the next beginning off-spill
phase (see SPS monitor or TCS Status window) the trigger is started and at the following
new spill data should arrive. At that point the LDC indicators should all move to RUNNING
and stay there until the run is stopped. If an LDC remains WAITING_START_OF_DATA, its
connected equipment somehow did not send data and probably needs to be reinitialized;
see section 5.4 for details.

State changes should happen for all GDCs or LDCs at roughly the same time. If one
computer consistently lags behind by more than a few seconds, please make a note in the
runLogbook and inform the DAQ expert.

2.4 The Status Display

This window is not visible in the disconnected state. If it does not appear after connecting
(or someone has closed it) you can open it using Show Status Display from the View menu.

Detailed information about all computers participating in the data taking is displayed
in the biggest window. The values are updated every second. This window gives a more
direct feeling that the run is really running, but the interpretation of the values is not always
straight forward. E.g. the trigger rates and numbers shown for the LDCs are not the ones
happening at the hardware in that very instant, but reflect how events are transferred from
the spillbuffer cards to the LDC’s main memory. Therefore the burst number displayed in
the Status Display might be smaller than the one displayed in the TCS Status window. The
event flows are divided across all GDCs, so the recording rates there need to be multiplied
by the number of GDCs to obtain the total rates.

In case of readout errors, the affected fields are highlighted, as is the respective label
on the left side. There should also be an audible alarm, which is played every ten seconds
if there are errors currently happening. In case of temporary errors, which go away after
one or two spills, leave the run running. But if the error persists, investigate and possibly
stop the run. A useful tool is the button displaying the Interface Status of each LDC. Press
it—especially the highlighted ones—to open a window detailing the Slinks and detectors
connected to the LDC and offering buttons to reload the hardware—which of course is only
enabled if no run is currently running.

3 Starting and Stopping Runs

In order to be able to start a run, the run control must be in state READY, indicated by
the pink background color of the Read to start label. If the state is DISCONNECTED or
CONNECTED, use the -buttons to reach the READY state. After carefully checking the
trigger selection (see section 4.2) and the online filter setting (see section 4.5), you are ready
to start the run.



3.1 Starting

Click the START RUN button. Before the action really starts, a small window appears asking
for the run type, which shall be recorded in the electronic logbook. You can click Cancel to
undo the starting of the run altogether, or Okay to proceed; but until you click one of the two
buttons, the rest of the run control will appear frozen and not respond to mouse clicks.

You might want to watch the SMI status window to check on the progress of the run.
As soon as all LDCs are in state WAITING_START_OF_DATA (see section 2.3 for details) the
run control enables the Stop button and awaits the first event. If that is not received by all
participating LDCs after at most 70 seconds the run is aborted automatically—normally the
time to receive the first event should be between 13 and 30 seconds. If you press Stop during
this time the run will end immediately without recording a single event. Otherwise, only
after all LDCs have received the first event, the run is started and recording begins.

3.2 Running

While the run is running you should check the MurphyTV and infoBrowser screens mounted
above the run control screens for error messages. In a perfect run there should be no red
source IDs on the former and no messages on the latter. In case of persisting non-fatal
messages—meaning that the run does not abort by itself and the messages are repeated for
the same LDC and interface or source ID across multiple runs—please inform the detector
expert. You can find out which detector is involved by looking at the lists attached to the
board in front of you (sorted by source ID or ROB slot aka LDC interface).

3.3 Stopping

The run can stop for three reasons:

e You pressed the Stop button. At the next begin of offspill time the TCS controller is
informed of your wish, so at the beginning of the next spill the last event in the run
will be sent from all detectors, causing the LDCs to shut down, which in turn lets the
GDCs stop after which the run is stopped.

e The maximum burst number was reached. This number can be set using the [->]-
button, also during the run, which copies the value entered in the left field to the right
field and thereby to the configuration memory of all connected computers. As soon
as the first LDC recognizes this situation, the same procedure is followed as in the
previous case.

e One LDC or GDC requested the end of run due to an error. This is informally known
as a “crashed run”. In that case the LDCs do not wait for the last event in the run but
shut down quickly. However, depending on the kind of error there might be timeouts
on individual computers which delay the procedure.

The stopping procedure is not yet free of bugs. While these bugs do not harm the data,
they might prevent a successful shutdown. Typically some LDCs don’t leave the STOP-
PING_RECORDER state. If no progress is made for 30 seconds the Abort button is activated.
You should press it if it stays clickable for more than a few seconds. After that the shutdown
should proceed quickly. If not consult section 5.5.



4 Configuration

This section covers the configuration topics relevant to shift crew use. Advanced configura-
tion beyond the scope covered here is to be done by the DAQ expert only!

4.1 Including/Excluding Detectors

Including or excluding certain detectors might change the set of LDCs required for the read-
out. Therefore the run control needs to be in the DISCONNECTED state to perform this
operation. Use the [<]-button in case this is not fulfilled.

The [Slink|-button invokes a new window with three parts. In the upper part you can
enable or disable whole detector types by clicking with the left mouse button on their re-
spective entries. If a detector type is read out via more than one link—this is the common
case—it might be that not all links are consistently enabled or disabled. In such a mixed
situation the entry for that detector type is grayed out and it cannot be clicked with the left
mouse button. Using the right mouse button selects the chosen detector type for closer dis-
play in the middle part of the window, where the individual links aka ROB slots are shown.
Here again the links can be switched on and off using the left mouse button on the entries or
on the all and none buttons, which bring the detector type into a consistent state if necessary.
The lower part of the window displays the Technical Board names of the detector planes
attached to the link selected in the middle part, unless there is no such information in the
Frontend Database for the selected readout modules.

All modifications on the Slinks are registered immediately in the database, and after
each click the current database contents is read and used for setting the state of the buttons.
Only the selection of LDCs participating in the data taking is done when the Done button is
pressed. This is why there is no Abort button as that could create an inconsistent situation.

In general during regular data taking all detectors should be enabled. However, in the
commissioning phase there might be people working on individual detectors, making it
necessary to exclude those in order to achieve successful running. If the error recovery steps
detailed in section 5 do not converge on a working setup, ask the respective detector experts
about possible reasons and /or workarounds.

4.2 Trigger Selection

When the DAQ is in state READY you can select the trigger setting by clicking on the [v]-
button in the trigger selection box. There are several predefined trigger compositions for
physics running, alignment, etc. The random_1, random_10 and random_100 selections contain
only random trigger, prescaled with divisors 1, 10 and 100, respectively. You can see the
effect of changing the trigger composition nearly in realtime—you have to wait 1-2 SPS
spills to allow for transient effects—in the TCS status window.

There is one special entry in the trigger menu labeled custom. Selecting it pops up a
window which allows direct setting of the prescaling divisors for all 12 hardware trigger
inputs. If you need a setting which is not available in the predefined set, use this tool.

4.3 Deadtime Selection

For detector calibration it might be necessary to read them in a slower latch all mode (e. g.
GEM and Silicon), which requires a different deadtime setting than the default. You can
select between several predefined settings using the menu button at the bottom part of the
TCS Status window.



4.4 Calibration Triggers

In addition to the hardware trigger the TCS can also generate artificial triggers with a fixed
rate. There are 26 different trigger types of this sort, enough to supply each detector type
with its own calibration trigger. In reality only a handful are really used. Most noticeably
the calorimeters need their LED pulser always running, which is connected to trigger type
13. In addition to the frequency (between 1Hz and 300Hz), the triggers can be enabled
separately for the onspill and offspill times, where in general it makes most sense during the
offspill, since then there are no accidental particle hits which might disturb the calibration
procedures.

The calibration triggers can be configured when the DAQ is in state READY. Click on
the [CalTrig]-button to get the configuration window. The state of the triggers is stored in
the TCS controller and the values shown when the window opens are read directly from
there. As soon as you are finished with your modification, click the Done button to write the
changes into the TCS controller.

Since the values are stores in the TCS controller FPGA, they are lost after a power cycle
of the crate housing pccofe02 or after issuing a LOAD -A 1025.

4.5 Online Filter

For physics data taking under normal trigger conditions we need the online filter to be able
to store all the data on disk and later on tape. Therefore the default setting of the filter
configuration should be “filter-active”. For details on how/when the button works see the
section 4.2.

However, the online filter—named Cinderella after the famous fairy tale—needs certain
detectors present and fully calibrated to function, so during commissioning or tests without
beam it should be set to “pass-through” or “off”; in the latter case the cinderella pro-
cesses are not even started, while in the former case the additional buffering provided by
cinderella can improve DAQ throughput.

If there is beam the online filter fulfills another important function, namely the readout
of the scalers for our integrated luminosity measurement. The values obtained for each spill
are stored in a database which is important for later analysis of the data. Unless there is a
very good reason and the week coordinator agrees, the filter configuration during runs with

i

SPS beam should always be “filter-active”, “mark-only” or “scaler-only”.

5 Error Recovery

These instructions are intended to make the COMPASS shift crew more efficient and to spare
the DAQ expert a few wakeup calls. Please make use of them, and only in case the problem
cannot be solved call the expert.

5.1 Console access to the computers in the DAQ barrack

All computers in the DAQ barrack are connected to a cascaded console switch. To invoke
its menu press the left [ctrl]-key three times in rapid succession. Then navigate the menu
to find the machine you are looking for. While eventbuilders are abbreviated EVB, ROBs are
registered as their native DATE name LDC, both matching the labels on the actual comput-
ers.

If there are problems accessing the console switch at all, try to reboot the KVM-over-IP
box, which is a long black device lying in the rack behind the screen. You can either use a



very narrow and long object to press the reset buttong (but you'll rarely find a tool fit for the
job), or you simply unplug and plug the power cord. After that wait a minute for the device
to restart.

5.2 Problems starting dateControl

If during the rcServer of executing the dateControl or dateStart commands some lines are
printed in red, immediate action is required. This typically involves accessing the console,
which is described in section 5.1.

Machine is dead signifies that there was a connection timeout which is usually caused by
the computer not responding to network traffic. It might be switched off or in a bad state. In
any case you need to go to the DAQ barrack, look at the console of the computer in question
and switch on or reboot. Please make a comment in the electronic logbook so that the DAQ
expert is up-to-date on the status of the system.

DATE services not running (restart xinetd?) means that the computer is alive but does not
properly respond to the DATE request. It is advisable to call the DAQ expert after checking
that a reboot (press [ctrl]{alt|-{del]| on the console after switching to the right computer)
does not fix it.

5.3 Connection problem with XXX

When going from DISCONNECTED to CONNECTED state, all participating rcServer pro-
cesses are asked for their status, and if any of them do not answer the runControl will go
back to the DISCONNECTED state after a timeout. In that case there is an error message
in the log of the run control main window. As a first step, try [dateStart|. This repeats
some of the steps described in section 1. If errors occur, follow the instructions of section 5.2,
otherwise try connecting again.

5.4 LDC does not receive START _OF _DATA within timeout

An LDC remains in the WAITING_START_OF_DATA state after the other LDCs moved on to
RUNNING if the connected equipment do not send any data (if corrupt data were sent, there
would be a specific error message mentioning this on the infoBrowser screen). Typically this
error stems from uninitialized frontend electronics. Issue the command |[LOAD -A pccorb<N>|,
replacing <N> by the LDC number(s) given in the error messages. If there are loading errors,
find out which detectors are involved (see FEDB listing above run control screens) and con-
tact the detector experts. Otherwise try again to start a run.

5.5 Run does not end

For each phase of the stopping of the run there is a 30sec timeout, after which the Abort but-
ton is enabled. If pressing this button does not result in a quick shutdown and the READY
state is not reached after some time, try and start the dateControl again. Re-
member to do this on pccorc01.



5.6 Run control windows are frozen/not repainted

Make sure that there is not a configuration dialog or runLogbook run type selection window
open anywhere. These pop up near the center of the screen and demand an immediate an-
swer; if they are moved out of the way to do something else the run control cannot continue
until the window is closed.

If the state is not caused by an open dialog window, issue a and start the
dateControl again. Remember to do this on pccorcO1.



6 DAQ Shutdown in case of a Power Cut

All computers in the DAQ barrack are connected to the UPS which also powers the emer-
gency lights and other systems. In contrast to the computing center we don’t have a diesel
generator to supply the DAQ with electricity during a power cut, which means that the
UPS battery’s main function is to allow a clean shutdown of the DAQ system in case of an
extended power failure. The nominal capacity allows for 10 minutes of full power consump-
tion, but as we use only about half the maximum current, the reserve should last around 20
minutes. This is more than enough time to shut everything down, but you should not waste
time in any case to leave as much energy as possible for the operation of the emergency
lights.

6.1 The Procedure

Go to the DAQ barrack and press the left [ctrl]-key three times in rapid succession. In the
console switch menu navigate to NEW-EVB, then PCCOFS01 and press enter. If the screen
is black, hit the enter key again. As soon as you see messages or the login prompt of the
file server, press the combination {alt |-{cursor up| This switches to a new console and
displays the DAQ control screen. Type shutdown DAQ to send the shutdown command to
all DAQ computers except for the file server. You should use the console switch to monitor
the shutdown sequence of all computers and as soon as they complete the sequence—either
by powering off or by displaying a message like “system halted” or “please switch power
off”—switch back to the file server and type shutdown fs. After the file server has switched
itself off, switch off manually those computers which did not power off themselves (these
are mainly some old ROBs).

Please do not switch off the fans in the cooling doors of the racks, since it would be fatal
to forget switching them on before powering on the computers. They use less power than
the emergency lights anyway.

6.2 Possible Complications

If the file server does not react, check that the console switch is working with other comput-
ers, and if that is the case, try to reboot the file server. If the console switch does not work,
power cycle it. If you don’t succeed within five minutes, start switching off the DAQ com-
puters using a manual sequence: navigate the console switch to each computer and press
the sequence of combinations

[alt |-{[PrtScr|{s], [alt -{[PrtScr|{u], [alt [-{PrtScr|{o]

For those computers which cannot power off by themselves, press the power switch
longer than 5 seconds to switch them off.

If some computer gets stuck during shutdown, maybe because the file server is already
shut down, use the manual shutdown sequence described above.

6.3 Switching on again after power is restored

It is imparative to switch on the file server PCCOFS01 first and wait for it to complete the
boot sequence. After that, switch on the database server PCCODBO01 and wait again for it
to complete the boot sequence. As soon as both servers are running, you can switch on all
other computers. Any DAQ computers—including run control and VME CPUs—booted
before the servers were running need to be rebooted at that point, otherwise the network
file systems might not work correctly.



7 Advanced Topics

The methods presented here are for experts only. Wrong use might result
in the destruction of the DAQ setup.

7.1 Running commands on all machines in parallel

The do_all script simplifies carrying out operations on a set of computers. Try it without
arguments or option -h for a short help. Options parsing ends at the first unrecognized op-
tion or at the -- token. If computers are selected which are not reachable, the script will wait
some time for a connection timeout unless option -w is given. Useful option combinations
are:

do_all -f eb <cmd> Invoke the command on all eventbuilders and in addi-
tion to writing a log file for each computer, print the out-
put generated by the command on the first one. Replace
eb with rb or fe to select ROBs or pccofes instead.

do_all -f eb -1 <cmd> Like the previous, but instead of writing log files print
the output of all computers on the screen. The output is
not ordered in any way and might be garbled.

do_all -f eb -s <cmd> Like the previous, but do the computers one after the
other. Takes much longer, but the output should be read-
able.

do_all -f eb -F ’22|23’ <cmd> Execute command on all eventbuilders except for 22 and
23.

If you want to start a program which waits for input but you don’t want to give any,
try option -i, which redirects standard input from /dev/null. Option -q suppresses any
output, logging the command’s output to files. Unless the -1 option is given, each selected
host is tested with a ping (timeout 1 second) before trying the SSH connection.

7.2 Accessing the Databases

Although there is really only one database server hosting the different COMPASS online
databases (runLogbook, Frontend Database, DATE configuration, DATE logging, Beam Da-
tabase), there are different possible access mechanisms, depending on the purpose. The
commonly used ones are described in the following sections.

7.2.1 SQL command line

As user dag, an alias named dateMysql opens a MySQL command line client with the DATE
configuration database of the current DATE site selected. If you are using this, you certainly
do know what you are doing, so the details are not described in this text.

7.2.2 DATE editDb

DATE comes with its own Tcl/ Tk based configuration tool. If you need to change shared
memory layout, event building rules or the pool of LDCs or GDCs, etc. use this tool. It uses



the notion of transactions, so after every change you made you have to press the “Commit”
button to actually write the modification to the database.

Remember that the enabling and disabling of equipments is completely handled by the
“Slink” button in the run control (see section 4.1).

7.2.3 Frontend Database

While it is not impossible to manipulate the FEDB with the SQL command line, it is strongly
discouraged. This database has a mechanism to record the history of changes which you can
easily break by manual intervention. The official tool for modifications is a web site at

http://pccodb01/cgi-bin/fedb/fedb.pl

Its use should be mostly self-explanatory. The single most-reported cause for user con-
fusion is an error message like Duplicate entry for key XXX, listing the names/IDs of the
equipment you tried to register. Each table has a primary key, which must be unique for
each database entry, and the error message tells you that you tried to register e.g. a De-
tector/Geographic_ID/Version_tag combination that exists (possibly with State=0) already.
You have to DELETE entries of equipment which is to be moved from one source ID to
another using the DEL setting in the Edit page.

7.2.4 TCS configuration

TCS takes its configuration files not from an actual file system, but instead reads their con-
tents from the database. They are stored as BLOBs in the FILES and FILES_PROT tables of
the Frontend Database (devdb). There are a set of tools to access and modify these files:

fdb_1s Lists all files in the selected database.

fdb_cat <host>:<path> Prints the selected file to the screen; this is not the same
as using fdb_cp and cat, because it might append a new-
line at the end of the file if there is none, which is usually
exactly what you want.

fdb_edit <host>:<path> Opens the selected file in an editor and writes it back after
editing.
fdb_rm <host>:<path> Deletes the selected file.

fdb_cp <host>:<path> <file> Copies the file from the database into the normal file sys-
tem.

fdb_cp <file> <host>:<path> Copies the file from the normal file system into the database.

All commands accept a set of options to select a database, user name, database server
name, password and to choose between the FILES and FILES_PROT tables:

-d <database> selects a database—e. g. devdb—instead of the DATE configuration database

-u <username> normally the daq user is enough, but for editing the FILES_PROT table only
the trigger user is authorized.

-h <server> you should not need to connect to a different than the default database
server



-p[password] isnecessary in case you want to connect as a different user than the default.
Giving the password on the command line is optional but discouraged,
because in that case anybody could see it in the process listing. Notice
the missing whitespace between option and argument (if an argument is
given).

-P selects the FILES_PROT table

-- ends the options parsing

For database pseudo-paths the ":” is mandatory, even if the <host> part remains empty.
The latter is only relevant for DATE’s configuration files as they are in separate databases
for each DATE site. TCS configuration of different sites is distinguished in the Frontend
Database by means of the “TCS name”, a string stored in $DATE_SITE_CONFIG/tcs_name—
you'll mostly need “main”, for the main DAQ. A hands on example would be

fdb_edit -d devdb -u trigger -p -P main:/tcs/tcs.config

You will be asked for the trigger password. There is a shortcut for the more frequently
used listing of the TCS configuration:

fdb_cat -d devdb -P ‘cat $DATE_SITE CONFIG/tcs_name‘:/tcs/<name>
is the same as
tcs_cat <name>

But beware that the file config/deadtime.config is stored in the unprivileged FILES
table (meaning that you have to use the long form without the -P) so that the shift crew can
select a deadtime setting via the TCS window (cf. section 4.3).



